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Custom Report Walkthrough:  

1. Custom Report Walkthrough
This document provides a simple walkthrough for creating a custom IP Office Customer Call Reporter report using
Microsoft Report Builder. 

The use of Report Builder to create custom reports is extensively covered in the applications own help files. This
document focuses on those elements that are specific to IP Office Customer Call Reporter such as the insertion of data
fields from the IP Office Customer Call Reporter database. The use of a custom report to run reports is covered by Avaya
IP Office Using IP Office Customer Call Reporter (15-601130). 

1.1 Downloading a Sample Report File
In order to start you need a sample IP Office Customer Call Reporter custom report file. A sample report is supplied with
IP Office Customer Call Reporter and can be downloaded by logging in as a supervisor. The sample contains IP Office
Customer Call Reporter information such as the available dataset definitions  that can be used in custom reports.

Downloading a Sample Report File
1.Log in to the Customer Call Reporting Web client as a supervisor.

2.Select Reports 

3.Select the Custom tab.

4.Click on the Download Base Custom Report link to download the sample file. 

26
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1.2 Getting Started
The report layout can be edited in Report Builder without requiring access to IP Office Customer Call Reporter and or the
SQL database. However the ability to connect to the SQL database if useful in that it allows you to run the report in order
to test and check the layout results.

Starting Report Builder
1.Start Report Builder using either of the following options.

· If you have Report Builder Installed 
From the desktop, select Programs | Microsoft SQL Server 2008 R2 Report Builder 3.0 | Report Builder
3.0. 

· To install and run Report Builder from IP Office Customer Call Reporter 
Using the Run Microsoft® Report Builder® 3.0 link within IP Office Customer Call Reporter. To use the link,
you may need the Windows user account credentials for the IP Office Customer Call Reporter server. If you are
using a non-IE browser, you also need the appropriate plug-in to be pre-installed.

2.From the Getting Started window, select Open and browse to the sample file that was downloaded from IP Office

Customer Call Reporter. Alternatively,  click on the Report Designer icon top left and select Open.

3.If you ran Report Builder using the IP Office Customer Call Reporter link, click the Disconnect link at the
bottom-left of the Report Builder window.

4.The sample report template is loading into Report Designer. 

5.For our example walkthrough, we will now add a simple data table . 7
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Custom Report Walkthrough: Getting Started

1.3 Adding a Calls Table
For this stage of the walkthrough, we will add a simple table that shows call data. When the report is run, the table will
show the selected fields for all calls in the report's date and time range specified when the report is run. 

Inserting a Table
1.Select the Table Dataset 

a. In the toolbar, select the Insert tab.

b.Select Table and click Table Wizard from the drop-down menu. The system displays the New Table or
Matrix window.

c. This menu is used to select the dataset which will be shown in the table. For our example we want call data so
select the Calls dataset and click Next.

2.Select the Table Data 
Having selected the dataset, we can now select the data items in that dataset that we want used. Select the fields
from this data set that should be included within the table as columns and the order in which those columns should
appear. 
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a.Drag and drop items from the Available Fields list to the Values list on the right. You can add multiple fields
by first using Ctrl or Shift to select the items before dragging them. 

b.You can reorder the fields within the Values list by dragging and dropping within the fields within the list. 

c. Click Next twice.

3.Select the Table Style 
The wizard has a number of predefined styles that can be applied to the table layout. 

a. Select an appearance style from the list 

b.Click Finish. The system displays the table on the report canvas. 

4.Position and Adjust the Table Size

a.To position the table on the page: 

Click the table and then click on the square in the top left corner. Click and drag the  icon to move the whole
table. 

b.To size the table: 
Click the table and then click on the square in the top left corner. Use the small squares on each corner and
edge to size the table. However, remember that tables will expand in height to show their full set of rows when
the report is run.

c. To resize individual rows and columns: 
Click on the table. You can then drag the boundaries shown at the top and left of the table. 

d.To change column headers: 
The top row is automatically treated as a header row and shows default names for the selected values. To
change any of the headers, click on the current text and enter the required text. 

We have now added a simple table of selected call data. Next we must group the data . 9



IP Office Customer Call Reporter Custom Report Walkthrough Page 9
- Issue 02a (Thursday, December 22, 2011)IP Office 8.0

Custom Report Walkthrough: Adding a Calls Table

1.3.1 Grouping the Table
For the simple table we have added, the system will display the first column of the table in a different style with plus and
minus buttons when the report is run. The remaining columns in the table remain unchanged. 

We can add a group field. When the report is run, the rows are grouped using the group field values. For this example we
will group together all calls with the same DDI.

Grouping Data
1.Click on the table. 

2.Right click on a table header. From the menu shown select Add Group. 

3.Click on the Parent Group option shown under Row Group. 

4.From the Group by: drop down select the data field on which you want to group the table rows. For this example
we have used Call_DDI_Number. Click OK.

We now have a simple table of call data where the calls in the table are group by DDI number. However, this table will
include all calls within the select time period for the report. We can add filters  to specify the particular calls that we
want added or excluded from the report. 

Alternate Method
The same effect could have been done when we were adding the table  using the table wizard by dragging the
Call_DDI_Number field from Available Fields to the Row Groups box. 

10

7
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1.3.2 Filtering the Table
The table we have added  and now grouped  will still include all calls that occurred in the time and date range
specified when the report is run in IP Office Customer Call Reporter. However, we can use filters to specify which calls
should be included or excluded. 

Applying a Filter
1.Click on the table to select it. Right click the square in the top left. 

2.Select Tablix Properties. 

3.Select Filters.

4.Click Add to create a new filter. 

5.For this example let us create a filter that includes only incoming external calls in the table. 

a. From the Expression drop down, select Call_Direction_Description. 

b.For the Operator select =. This is selected by default but other operators such as <> (not) can be used. 

c. For the Value enter External. 

6.We have now created a filter to include only data where Call_Direction_Description = External. 

· We could add additional filters if required. If we added multiple filters, the order in which the filters are applied
to the data can be adjusted. For example a filter using Queue_Name could be used to report only on a specific
queue's calls. 

7.Click OK. 

We have now defined our table and filtered the data included in it. We will now add a summary row to the table . 

7 9

11
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Custom Report Walkthrough: Adding a Calls Table

1.3.3 Summarizing the Table
It is a common requirement to have a summary row in a table. 

Adding a Table Summary Row
1.Click on the table to select it. 

2.Right click the left side of the bottom row in the table. From the menu select Insert Row > Outside Group –
Below. A new blank row in added to the bottom of the table. 

3.In each cell of the new row, you can select what information you want displayed. 

· To add a text label, double click on the cell and enter the text required. 

· To add a data value or information item, right click on the cell and select Expression. This form can be used to
add specific values or to create an expression (formula) for a required value. 

4.For our example we might want a count of the number of calls to appear in a cell. 

a. Right click on the cell and select Expression. 

b. In the Category column, under Common Functions select Aggregate. In the Item column, double click on
Count Distinct. The item is added to the expression value. 

c. In the Category column, select Fields (Calls). The fields of the dataset being used for the table are shown in
the Item column. Locate and double click on Call_ID. 

d.Add a closing ) bracket to the expression. We now have an expression =CountDistinct(Fields!Call_ID.Value)
. This will return a count of the number of unique calls included in the table. 

5.Click OK.
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1.4 Adding an Agents Table
In the previous example stages we have added, grouped, filtered and summarized a table of call data. The same
methods can be used to create tables for queue data and for agent data. 

For this example let us add a table of statistics for the agents and sort them by the number of calls answered. First we
must add a table using the Agents dataset. This is similar to our previous example of adding a table for the Calls
dataset. 

Inserting a Table
1.Select the Table Dataset 

a. In the toolbar, select the Insert tab.

b.Select Table and click Table Wizard from the drop-down menu. The system displays the New Table or
Matrix window.

a. This menu is used to select the dataset which will be shown in the table. Select the Agents dataset and click
Next.
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Custom Report Walkthrough: Adding an Agents Table

2.Select the Table Data 
Having selected the dataset, we can now select the fields from the dataset that we want used. Select the fields
from this data set that should be included within the table as columns and the order in which those columns should
appear. 

a.Drag and drop items from the Available Fields list to the Values list on the right. You can add multiple fields
by first using Ctrl or Shift to select the items before dragging them. 

b.You can reorder the fields within the Values list by dragging and dropping within the fields within the list. 

c. Click Next twice.

3.Select the Table Style 
The wizard has a number of predefined styles that can be applied to the table layout. 

a. Select an appearance style from the list 

b.Click Finish. The system displays the table on the report canvas. 

4.Position and Adjust the Table Size

a.To position the table on the page: 

Click the table and then click on the square in the top left corner. Click and drag the  icon to move the whole
table. 

b.To size the table: 
Click the table and then click on the square in the top left corner. Use the small squares on each corner and
edge to size the table. However, remember that tables will expand in height to show their full set of rows when
the report is run.

c. To resize individual rows and columns: 
Click on the table. You can then drag the boundaries shown at the top and left of the table. 

d.To change column headers: 
The top row is automatically treated as a header row and shows default names for the selected values. To
change any of the headers, click on the current text and enter the required text. 

We now have a simple table of agent statistics. We could also group, filter, and summarize the agent data as we did for
the calls table. However, for this example let us sort the table  by order of how many calls each agent has answered in
order to rank the agents.

14
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1.4.1 Sorting the Table
The data in a table can be sorted. The sort can be done on any field in the dataset selected. However, it does not have to
be one of the fields actually shown in the table. In this case the field is shown, as we are reporting on how many calls
each agent has handled and ranking the agents by calls answered. 

Sorting a Table
1.Click on the table to select it. Right click the square in the top left. 

2.Select Tablix Properties. 

3.Select Sorting. 

4.To add a sort option: 

a.Click Add. 

b. In the Sort by drop down, select the dataset field on which to sort the table. For this example we want
Agent_Answered_Calls. 

c. In the Order drop down select the required sort order. We want the highest number of calls to be first so for
this example select Z to A.

5.You can add additional sort options and adjust the order in which each sort is applied. For this example we only
need the single sorting option. 

6.Click OK. 
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Custom Report Walkthrough: Adding an Agents Table

1.5 Charting Refused Calls
In addition to data tables, we can use the Report Builder to chart data. For this example we want a simple pie chart of
calls refused by agents. That is calls presented but not answered. 

Adding a Chart
1. Select the Chart Dataset 

a. In the toolbar, select the Insert tab. 

b.Select Chart and click Chart Wizard from the drop-down menu. The system displays the New Chart window.

c. This menu is used to select the dataset which will be shown in the chart. For our example we want agent data
so select the Agents dataset and click Next.

2.Select the Chart Type 
Having selected the dataset, we can now select the type of chart. 

a. Select the type of chart to include. For this example select Pie. Click Next. 

3.Select the Chart Data 
We must now select which fields from the dataset are used for the chart.
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a.Click and drag Agent_Name from the Available fields list to the Categories list. This sets the label used for
each pie segment. 

b.Click and drag Agent_Refused_Calls from the Available fields list to the Values list. This sets the values
used to set the relative size of each pie segments. 

c. Select the arrow at the right of the entry in the Values list. Select First from the drop-down list. 

d.Click Next.

3.Select the Chart Style 
The wizard has a number of predefined styles that can be applied to the chart layout. 

a. Select an appearance style from the list 

b.Click Finish. The system displays the chart on the report canvas. 

4.Position and Adjust the Chart Size

a.To position the chart on the page: 

Click the chart and then click on the square in the top left corner. Click and drag the  icon to move the whole
chart. 

b.To size the chart: 
Click the chart and then click on the square in the top left corner. Use the small squares on each corner and
edge to size the chart. 

e.To change the title: 
Double click the text shown for the current chart title. Enter the title required.

When you run this chart, it will have one pie segment for each agent with a non-zero number of refused calls. Since no
filters have been added yet, all refused calls by all agents in the period specified when the report is run are included. 

There are many other properties displayed on property sheets for the chart. You can control the formatting and
presentation of the chart by using chart area, legend, and series. To access each, click on the chart and then right-click
on the chart element that you want to adjust and select the required formatting option. 
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Custom Report Walkthrough: Charting Refused Calls

1.5.1 Filtering the Chart
In addition to filtering tables  you can also filter the data used for a chart. For this example, if we have a large number
of agents and are reporting for a long period, the chart may be unclear if it includes all agents. So, let us apply a filter
that only includes agents with 5 or more refused calls. 

Adding a Filter
1.Right click on the top left corner of the chart and select Chart Properties. 

2.Select Filters. 

a. From the Expression drop down, select Agent_Refused_Calls. 

b.For the Operator select >= for greater than or equal to. 

c. For the Value enter 5. 

6.We have now created a filter to include only data where Agent_Refused_Calls >= 5. We could add additional
filters if required. If we added multiple filters, the order in which the filters are applied to the data can be adjusted. 

7.Click OK. 

10
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1.6 Charting Queue Performance
In this example we will add another chart. This time the chart will show the grade of service achieved by each of the
queues as a bar chart.

Adding a Chart
1. Select the Chart Dataset 

a. In the toolbar, select the Insert tab. 

b.Select Chart and click Chart Wizard from the drop-down menu. The system displays the New Chart window.

c. This menu is used to select the dataset which will be shown in the chart. For our example we want agent data
so select the Queues dataset and click Next.

2.Select the Chart Type 
Having selected the dataset, we can now select the type of chart. 

a. Select the type of chart to include. For this example select Bar. Click Next. 

3.Select the Chart Data 
We must now select the fields from the dataset that are used for the chart.
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Custom Report Walkthrough: Charting Queue Performance

b.Click and drag Queue_Name from the Available fields list to the Categories list. This sets the x-axis label for
each bar in the chart. 

c. Click and drag Queue_Grade_Of_Service_Percentage from the Available fields list to the Values list. This
sets the values used to set the relative size of each bar. 

d.Select the arrow at the right of the entry in the Values list. Select First from the drop-down list. 

e.Click Next.

3.Select the Chart Style 
The wizard has a number of predefined styles that can be applied to the chart layout. 

a. Select an appearance style from the list 

b.Click Finish. The system displays the chart on the report canvas. 

4.Position and Adjust the Chart Size

a.To position the chart on the page: 

Click the chart and then click on the square in the top left corner. Click and drag the  icon to move the whole
chart. 

b.To size the chart: 
Click the chart and then click on the square in the top left corner. Use the small squares on each corner and
edge to size the chart. 

f. To change the title: 
Double click the text shown for the current chart title. Enter the title required.

When you run this chart, it contains bar per queue. The size of each bar will reflects that queues grade of service
percentage. 

There are many other properties displayed on property sheets for the chart. You can control the formatting and
presentation of the chart by using chart area, legend, and series. To access each, click on the chart and then right click
on the chart element that you want to adjust and select the required formatting option. 
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1.7 Gauge for System Performance
Traditional charts are useful for displaying and comparing multiple data values, for example values for each agent or each
queue. For single data values such as system values gauges can be used. The Report Designer provides a range of styles
of gauges such as rulers, thermometers, speedometers, etc. 

In the previous example we added a bar chart to show the grade of service achieved by each queue. In this example we
will add a gauge to show the overall grade of service for the whole system. 

1.Select the Gauge Type 

a. In the toolbar, select the Insert tab.

b.Select Gauge. 

c. Click on the report canvas. The range of possible gauges is shown. 

d.Select the type of gauge required. For this example we will use a simple dial gauge. Click OK.

e. The gauge is added to the report canvas. Use the  control to drag the gauge to the required position. Click
and drag the small squares on the sides and corners to adjust the size of the gauge.

2.Select the Gauge Data 

a. Click on the gauge. The Gauge Data panel is displayed. 

b.Click on the Unspecified drop down and select Avaya_IPOCCR_Custom_Reporting > System >
System_Grade_Of_Service_Percent. 

· You can also select the gauge data by right clicking on the gauge pointer and selecting Pointer Properties.

3.Adjust the Scale 
The default scale is 0 to 100. However we aim to maintain a high grade of service and want the dial to have a
range of 60 to 100. 
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Custom Report Walkthrough: Gauge for System Performance

a.Right-click the scale within the gauge and select Scale Properties. 

b.Change the minimum value to 60. 

c. Right-click the pointer or marker within the gauge and select Pointer Properties from the context menu. 

d.The system displays the Pointer Properties window. 

e.Select the field value to use for the pointer from the entries presented in the Value drop-down list. For the
example, select the System_Grade_Of_Service_Percent field for system performance.

You can add multiple pointers with different values to the same scale. Right click the existing scale and select Add
Pointer. 

There are many other properties displayed on property sheets for the gauge. You can control the formatting and
presentation of the gauge by using the gauge panel, series and pointers. You can add label captions for the gauge,
series, and pointers. 
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1.8 Adding Text and Other Data Values
Data contained in the datasets such as Agents, Queues and Calls are added via inserting an item such as a table or a
chart, as each dataset contains multiple rows of data for each field. These must be filtered, sorted, and so on.

The System and Voicemail datasets are unique in that they both only contain a single row of data. Therefore, you can
include fields from those datasets on a report without having to first format them via a table, matrix list or chart. Instead
they can be included in a gauge  or added directly to a report as text fields as shown below.

Similarly there are a range of non-dataset values that can be added to a report using a similar method as below. For
example the Parameters values such as StartDate entered when a report is run and Built-in Fields such as Page
Number.

Adding and Labeling Single Data Values
1.In the Report Data panel on the left, expand the Datasets folder. 

2.Expand the Voicemail dataset.

3.Click on Total_Answered_Calls and drag it onto the report. You will see a text box added on the report canvas.
When you run the report, the text box will contain the value for the number of calls answered by voicemail during
the report period. 

a.To position the text box: 

Click near the edge of the text box. Click and drag the  icon to move the whole box. 

b.To size the text box: 
Click near the edge of the text box. Use the small squares on each corner and edge to size the text box. 

c. To change the text formatting: 
Right click on the text box and select Text Properties. 

4.We must add another text box to act as a label for the value.

a. In the toolbar, select the Insert tab.

b.Select Text Box. Click on the canvas in the rough position where the text box is required. 

c. To enter the text, double click on the text box and type the text required. 

d.To adjust the text box layout use the same options are above for the dataset value. 

20
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Custom Report Walkthrough: Adding Text and Other Data Values

1.9 Adding a Document Map
A document map appears as a navigation tree on the left-side of the report when it is run. When you generate the map,
the document map acts as a set of links to the different sections of the report, based on the label given to the tree node. 

The presentation style of the document map depends on the viewing format of the report. PDF renders a document map
as the Bookmarks pane. Excel renders a document map as a named worksheet that includes a hierarchy of links. Report
sections are rendered in separate worksheets that are included with the document map in the same workbook. Word
includes a document map as the table of contents. 

The document map is only shown if document map labels are set on an object or objects in the report. If there are no
labeled objects the document map is not shown. 

To Add a Document Map Label to an Item
Items added to the report layout are only listed in the document map if they have a document map label. This is added
via the properties settings of the selected object on the report canvas. 

1.Click on the object, for example a text box, to which you wish to add a document map label. 

2.In the Properties panel on the right, scroll down to Other. 

· If the Properties panel is not visible, click on the View tab and check that the Properties check box is
selected. 

3.Expand Other and locate the DocumentMapLabel property. 

4.Enter the label that should be used for the object location in the document map. 

1.10 Saving the Report File
Once the report has been setup as required, it must be saved with a new name. 

Saving the Report File

1.Click the  icon top left and select Save As. 

2.Enter a name for the report file and click Save. 
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1.11 Uploading the Report File
In order to use a custom report type, the Report Builder file must first be uploaded to the IP Office Customer Call
Reporter supervisor's account. 

Uploading a Report File
1.Login to IP Office Customer Call Reporter as a supervisor. 

2.Click on the Reports  icon. 

3.Click on the Custom tab. 

4.Click Upload. The system displays Report Name and the Select File fields.

5.In the Report Name field, enter a name for the report.

6.Click Browse and locate the file that you want uploaded. The file path will appear in the Select File field. 

7.Click OK. 

8.The new custom report type is now listed on the Custom tab. 

9.You can now use that custom report type to create saved report templates and run reports by clicking on the 
right arrow icon. Refer Avaya IP Office Using IP Office Customer Call Reporter (15-601130).
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Dataset Definitions

Chapter 2.
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2. Dataset Definitions
The following table lists the fields that can be accessed for generating custom reports. Most of the types are self-
explanatory. Those that are type Condition (Boolean values) take the value 0 or 1. 

Field Name Type Definition

Agent_After_Call_Work_Time Time
duration

Total time for which the agent's extension is in the After Call Work (ACW) state. It is the
sum of all the items that are displayed in the ACW Time column of Agent Summary Report
and correspond to the ACW times in the queues that the agent is a member of. ACW state
indicates that the agent is not available to receive queue calls while they perform some
other call-related activity. ACW state is independent of queue memberships and enabled
state and is typically used for activities such as creating call records and data entry that
need to be completed before handling another call. A number of controls are available for
ACW. Agents can be configured to be automatically put into the ACW state after a queue
call or they can manually select to enter the state when required. 

Note: The ACW state is similar to busy wrap up of the CCC product. 

Agent_Answered_Calls Numeric Number of queue calls that are answered by the agents. It is same as the item displayed in
the Answered Calls column in Call Summary Report. It includes the calls that are displayed
as routed to other in real-time. It does not include queue calls that are answered by non-
queue members using methods such as call pickup, calls that go to voicemail, and direct
calls answered by agents.

Agent_Average_Answer_Time_
Seconds

Time span Average answer time for an agent calculated as a simple, non-weighted mean of the call
answer times. It is same as the item displayed in the Average Answer Time column in Call
Summary Report. It is the sum of the answer times in seconds for answered queue calls
divided by the number of answered queue calls. The system considers the calls received by
a particular agent or a queue irrespective of the answer threshold setting. The average
answer time for a call is measured from it arriving at the queue or agent, but there may be
a delay between the time a call is presented to a queue and the time the call arrives to the
agent. It does not include direct calls to the agent. For example, if an agent has only
answered one queue call in 6 seconds and then a second queue call in 8 seconds, the
average answer time is 7 seconds. If the agent has answered no calls, then the value is 0.

Agent_Busy_Not_Available_Tim
e

Time
duration

Total time for which an agent's extension is in the Busy Not Available state. It is the sum of
all the items that are displayed in the Busy Not Available Time column of Agent Summary
Report and correspond to the Busy Not Available times in the queues that the agent is a
member of. The Busy Not Available state indicates that an agent is not available to receive
calls while performing an activity that is not call-related such as attending a meeting. It is
independent of queue memberships and enabled state. This state can be selected by an
agent using the Do Not Disturb (DND) or Send All Calls (SAC) button of the telephone. This
also requires the agent to select one of the reason codes displayed on the telephone to
indicate the reason for getting into the Busy Not Available state. If this state is enabled
while a queue call is being presented, the call will go to the next available agent and cause
the No Answer statistic for the agent and the queue to be incremented. An agent using the
DND or SAC feature is treated as selecting the Busy Not Available state.

Agent_Customer_Calls Numeric Total number of unique calls handled by an agent, that is, the number of calls with unique
values for the Call_ID field as displayed in the Customer Calls column in Call Summary
Report.

Agent_Hold_Time Time
duration

Total time for which the agent had calls on hold or had calls parked. It is the sum of all the
hold times in the queues that the agent is a member of, as displayed in the Hold Time
column in Agent Summary Report. In this state the agent is not talking to a caller.

Agent_ID Numeric Unique identification number for an agent, as used in system configuration.

Agent_Inbound_Talk_Time Time
duration

Total time that the agent spent on incoming answered queue calls, excluding the ringing
time. It is the sum of all the inbound talk times in the queues that the agent is a member
of, as displayed in the Talk Inbound column in Agent Summary Report. It includes talk
times for incoming external trunk calls only. It does not include the talk times for direct
calls, internal calls, and outgoing external calls. It excludes the hold, parked, and ACW call
times. It does not include queue calls answered by non-queue members using methods
such as call pickup.

Agent_Internal_Talk_Time Time
duration

Total time that the agent spent on calls between internal parties, inbound, and outbound.
It is the sum of all the internal talk times in the queues that the agent is a member of, as
displayed in the Talk Internal column of Agent Summary Report. It includes the ringing
time for direct calls, but not for queue calls. It does not include held, parked, and ACW call
time. It does not include queue calls answered by non-queue members using methods such
as call pickup.

Agent_Lost_Calls Numeric Number of queue calls lost by the agent, as displayed in the Lost Calls column of Call
Summary Report. A lost call is one where the caller disconnects before the call is answered
by the agent. The lost call threshold does not impact this statistic. Queue calls that are lost
are reported as lost against both the queue and the last agent to who the call is presented.
It does not include calls that are routed to voicemail.

Agent_Name Alphanume
ric

Username of the agent configured in the IP Office Telephone System, as displayed in the
first column of Call Summary Report for agents.

Agent_Non_Queue_Time Time
duration

Total time for which the agent is talking on incoming direct calls, including the ringing
times. It is the sum of all the non-queue times in the queues that the agent is a member
of, as displayed in the Non-Queue Time column of Agent Summary Report. It is
independent of queue memberships and state.
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Dataset Definitions:  

Field Name Type Definition

Agent_Off_Hook_Time Time
duration

Total time for which the agent's extension is off hook but is not connected to a trunk. It is
the sum of all the off hook times in the queues that the agent is a member of, as displayed
in the Off Hook Time column of Agent Summary Report. It is independent of queue
memberships or enabled state. Off hook is a telephony term for the state when the
handset on a traditional telephone is lifted from the phone, but here it is used for any state
where the agent's telephone is in use but not connected to a call. It includes the time taken
to pick up handset and dial a call and the ringing time. For an external trunk, it is the time
taken until the trunk is seized. 

Agent_Outbound_Talk_Time Time
duration

Total time spent by an agent on direct outbound calls, including the ringing time. It is the
sum of all the outbound talk times in the queues that the agent is a member of, as
displayed in the Outbound Talk column of Agent Summary Report. It is independent of
queue memberships or enabled state. It does not the talk times for internal calls. It
excludes the hold, parked, and ACW call times. It is unlike the real-time talk outbound
statistic which considers only the time from when an agent gets connected to an external
call. 

Agent_Presented_Calls Numeric Sum of answered, lost, and routed to voicemail call statistics for an agent. For agents, it
includes direct calls. For queues, it does not include direct calls and enquiry calls. The same
call may be presented more than once, therefore this value is different from the number of
unique customer calls. This statistic has the same value as those in the Call Interactions
column of Call Summary Report, but not the same as Call Interactions in the Call Details
Report summary box.

Agent_Queue_Enabled_Time Time
duration

Total time for which an agent is logged in and has the membership of any queue reported
enabled. It is the sum of all the enabled times in the queues that the agent is a member of,
as displayed in the HG Enabled Time column of Agent Summary Report.

Agent_Refused_Calls Numeric Number of times a call is presented to an agent and not answered before it is presented to
another agent, as displayed in the No Answer (Timeout) column of Call Summary Report.
For an agent, it shows the number of queue calls presented to the agent which rang
unanswered for the queue's full no answer time before it is presented elsewhere. It
includes queue calls and queue calls that overflowed to the agent's queue. It does not
include direct calls. If an agent enables the Busy Not Available state while being presented
with a queue call, it is counted against the agent and the queue. 

Agent_Ringing_Time Time
duration

Total time for which the agent's extension is ringing for incoming queue calls. It is the sum
of all the ringing times in the queues that the agent is a member of, as displayed in the
Ringing Time column of Agent Summary Report. Ringing time is when the agent is
presented with a call targeted to a queue that the agent is a member of.

Agent_Routed_To_Voicemail Numeric Number of queue calls presented to an agent that were then routed to voicemail, as
displayed in the Routed To Voicemail column of Call Summary Report. It does not include
announcements played by the voicemail server to the caller.

Agent_Total_Calls Numeric Sum of answered, lost, routed to voicemail, and refused call statistics for an agent. This is
the sum of the presented calls and the refused calls for an agent, as displayed in the Call
Interactions and No Answer (Timeout) columns of Call Summary Report.

Agent_Within_Answer_Threshol
d_Calls

Numeric Number of answered calls for an agent that are answered within the answer threshold.

Alarm_Clear_Date_Time Date and
Time

Date and time when the alarm or warning is cleared. It is empty if the alarm is active. It is
displayed after a hyphen in the Time Stamp column of Alarm Report.

Alarm_Definition_ID Numeric Unique identification number for the real-time alarm definition, as used in system
configuration.

Alarm_Definition_State_Descrip
tion

Alphanume
ric

Agent or queue state to which a state based alarm is targeted. It is empty for non agent or
queue state based alarms. It is displayed after a hyphen in the Statistic Name column of
Alarm Report.

Alarm_Definition_State_ID Numeric Identification number for agent or queue state to which state based alarm is targeted. It is
zero for non agent or queue state based alarms, as used in system configuration.

Alarm_Definition_Statistic_Desc
ription

Alphanume
ric

Name of the real-time statistic which is subject to the alarm, as displayed in the Statistic
Name column of Alarm Report.

Alarm_Definition_Statistic_ID Numeric Identification number for real-time statistic which is subject to the alarm, as used in system
configuration.

Alarm_ID Numeric Unique identification number for triggering of the real-time alarm warning or alarm, as
used in system configuration.

Alarm_Reason_Description Alphanume
ric

The Busy Not Available reason code associated with an agent state based alarm where the
agent state is Busy Not Available. It is displayed in brackets in the Statistic Name column of
Alarm Report for relevant alarms. For agents on the 1400, 1600, 2400, 5400, 4600, 5600,
9500 and 9600 Series telephones with available programmable buttons, when they select
the Busy Not Available state using a button on their phone, they are prompted to select a
reason code, if any has been configured on the telephone system. The codes are
configured on the telephone system by the system maintainer. Up to eight custom reasons
can be configured in addition to the following two fixed reasons:

1.Automatic - This reason is used if the agents are using a telephone that allows reason
code selection but fail to select a reason. For example, if they enable Busy Not Available
through a short code, using Phone Manager, or are forced into it by the IP Office's Agent
Status on No Answer feature. 

2.Unsupported - This reason code is used for agents using telephones that do not allow
the selection of a reason code.

Alarm_Status_Description Alphanume
ric

Description of the alarm state, whether it is an alarm or a warning that is triggered, as
displayed in the Type column of Alarm Report.

Alarm_Status_ID Numeric Identification number for the alarm warning or alarm state, as used in system
configuration.
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Field Name Type Definition

Alarm_Target_Name Alphanume
ric

Name of the queue or username of the agent that triggers the warning or alarm, as
displayed in the Target Name column of Alarm Report.

Alarm_Trigger_Date_Time Date and
Time

Date and time when the alarm or warning is triggered, as displayed in the Time Stamp
column of Alarm Report before any hyphen and clear date and time.

Alarm_Trigger_Value Numeric Value of the real-time statistic when the alarm or warning trigger occurred, as displayed in
the Value column of Alarm Report.

Call_Agent_Name Alphanume
ric

Username of the agent who answered the call, the overflowed call, or the transferred call,
according to the call status. It is displayed in the Agent column of Call Details Report.

Call_CLI_Number Alphanume
ric

For inbound calls, this is the CLI or telephone number of the caller provided with the call.
For outbound calls, this is the number dialed by the agent. For outgoing external calls, the
system can partially mask the number according to privacy settings configured by the
system administrator. This is displayed in the CLI column of Call Details Report. It is also
known as the CLID or ICLID (Incoming Calling Line ID).

Call_Date_Time Date and
Time

Date and time of the call, the overflow, the transfer, the putting on hold or the start of the
enquiry call ring, depending on the call status. It is displayed in the Date - Time column of
Call Details Report.

Call_DDI_Number Alphanume
ric

For incoming calls, this is the destination number received. For outbound calls, this is the
destination number used to make the call. It is displayed in the DDI column of Call Details
Report.

Call_Direction_Description Alphanume
ric

Description of the call direction, Inbound or Outbound for external calls and Internal for
internal calls, as displayed in the Call Direction column of Call Details Report.

Call_Direction_ID Numeric Identification number of the call direction, as used in system configuration.

Call_ID Numeric Identification number of the call, as used in system configuration. It is unique per call
handled by the IP Office Telephone System, even if the system is rebooted. It is not unique
within the data set since the set contains all call events for a single call such as transfers,
holds, and overflows.

Call_Or_Held_Duration Time
duration

Total call duration or the hold duration depending on call status. No duration is shown for
overflowed lost calls or routed to voicemail call status and the value may be empty for
other call status. It is displayed in the Duration column of Call Details Report. The duration
for the hold call status is the time until a transfer is completed. The duration for the
transfer call status is from the transfer initiation to the end of the transfer (i.e. it includes
the duration of the enquiry call). The duration for the enquiry answered call status, is from
the agent answering to the transfer being completed.

Call_Or_Overflow_Queue_Time Time
duration

Time from when the call arrived until it was answered, was lost, or it overflowed. It is not
displayed for calls that are routed to voicemail and may be empty for some call status. It is
displayed in the Queue Timed column of Call Details Report. For the enquiry answered call
status, it is the ringing time of the enquiry call and when answering a transfer, it is the
time from the initial queuing at the transferee until the transfer is completed.

Call_Record_Count Numeric Number of rows present in the data set that have the same Call_ID as the current row.

Call_Record_Index Numeric Index number running from 1 to the value of the Call_Record_Count field, representing
each call status event for the current call, accounting for each call hold, transfer, overflow,
and voicemail event.

Call_Reference_Number Numeric Identification number assigned to the call by the IP Office telephone system. It is unique
and automatically incrementing until the system is rebooted, remaining with the call whilst
it is handled by the system. This is displayed as Reference in Trace Report. It may be
empty if an agent event is not associated with a call and for the enquiry answered call
status, it is the new call reference. It is not unique within the data set since the set
contains all call events for a single call such as holds and overflows.

Call_Reference_Number_Format
ted

Alphanume
ric

Identification number assigned to the call by the IP Office telephone system. It is unique
and automatically incrementing until the system is rebooted, remaining with the call whilst
it is handled by the system. This value is the six character string formatted version of the
Call_Reference_Number field, as displayed in the Reference column of Call Details Report.
For enquiry answered call status, it is the new call reference.

Call_Status_Description Alphanume
ric

Overall description of the call status, as displayed in the Status column of Call Details
Report. The status Answered is applied to all calls that go to voicemail. Possible English
values are: Answered, No Answer, Overflowed Answered, Enquiry Answered, Not
Answered, Lost, Overflowed Lost, Holding, Transferred and Routed to Voicemail.

Call_Status_ID Numeric Identification number for the call status, as used in the system configuration.

Call_Transfer_Agent_Name Alphanume
ric

Username of the agent to who the call was transferred for calls with the status Transferred.
It is empty for any other call status. It is used in the Agent grouping option of Call Details
Report, to show transferred calls grouped against the transfer agent.

Downtime_Connected_Date_Ti
me

Date and
Time

Date and time of the end of a time period of downtime when the system was unable to
communicate with the IP Office telephone system. It may be empty if the communication
loss is ongoing. It is displayed in the Connection Restored column of Communication Failure
Report.

Downtime_Disconnected_Date_
Time

Date and
Time

Date and time of the beginning of a time period of downtime when the system was unable
to communicate with the IP Office telephone system. It is displayed in the Connection Lost
column of Communication Failure Report.

Downtime_ID Numeric Unique identification number for period of downtime experienced by the IP Office telephone
system.

Event_Activity_Description Alphanume
ric

Description of the agent activity, as displayed in the Event Name column of Trace Report.

Event_Activity_ID Numeric Identification number for the agent activity, as used in system configuration.

Event_ID Numeric Unique identification number for the agent event, as used in system configuration.
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Field Name Type Definition

Event_Number Alphanume
ric

For agent events that are related to a call, this is the CLI received with the call for incoming
calls and it is the number dialed for outgoing calls. In non call related agent events, the
value will be empty. For outgoing external calls, the system can partially mask the number
according to privacy settings configured by the system administrator. It is displayed in the
Number column of Trace Report.

Event_Start_Date_Time Date and
time

Date and time of the agent event, as displayed in the Date - Time column of Trace Report.

LIMITED Condition Condition that indicates if the number of rows in the data set has been limited due to the
configured maximum number of rows set by the system administrator. It applies
independently for each data set where the field is located. If any data set is limited, then a
warning message will also be displayed when the report is manually generated.

Queue_After_Call_Work_Time Time
duration

Total time for which the agent's extension is in the ACW state, for all agents in the queue,
as displayed in the ACW Time group summary box of Agent Summary Report. The ACW
state indicates that an agent is not available to receive queue calls while performing some
other call-related activity. It is independent of queue memberships and enabled state.
Typically it is used for activities such as call records and data entry that need to be
completed before handling another call. A number of controls are available for ACW. Agents
can be configured to be automatically put into the ACW state after a queue call or they can
manually select to enter the state when required. 

Note: The ACW state is similar to busy wrap up of the CCC product.

Queue_Answered_Calls Numeric Number of queue calls that agents in the queue have answered, as displayed in the
Answered Calls column of Call Summary Report. This includes calls that are shown as
routed to other in real-time. It does not include queue calls answered by non-queue
members using methods such as call pickup, or calls that go to voicemail, or direct calls
answered by agents. Once a call has overflowed, then if it is answered, it is reported as
overflowed answered against the queue.

Queue_Average_Abandon_Time Time
duration

For lost queue calls, this is the average time from when the calls were received by the IP
Office system till they were lost, as displayed in the Average Abandon Time column of Call
Summary Report. It is a simple mean (non-weighted average) of call abandon times for
individual lost calls. For example, if an agent has lost one call after 6 seconds and lost
another call after 8 seconds, this would result in an Average Abandon Time of 7 seconds. If
no queue calls have been lost, then the value is 0.

Queue_Average_Answer_Time_
Seconds

Time
duration

Average duration of the answer time for the queue calculated as a simple, non-weighted
mean of the call answer times, as displayed in the Average Answer Time column of Call
Summary Report. This is the sum of the answer times for answered queue calls divided by
the number of answered queue calls, displayed in seconds. The system considers the calls
received by a particular agent or a queue irrespective of the answer threshold setting. The
average answer time of a call is measured from it arriving at the queue or agent, but there
may be a delay between the time a call is presented to a queue and the time the call
arrives to an agent. For example, if a queue has answered one call in 6 seconds and
another call in 8 seconds, this would result in an Average Answer Time of 7 seconds. If the
queue has answered no calls, then the value is 0.

Queue_Average_Speed_To_Ans
wer_Percent

Numeric Number of calls answered within the answer threshold time, divided by the total number of
calls answered, expressed as a percentage, as displayed in the Average Answer Time (%)
column of Call Summary Report. It shows the number of queue calls answered by the
queue within the specified answer threshold time, divided by the total number of calls
answered. It includes overflow answered calls. For example, with an answer threshold of 30
seconds, 35 calls into a queue were answered within the target time, 5 calls were answered
after 30 seconds (no overflows). The calculation would be (Answered Within Threshold +
Overflow Answered Within Threshold) / (Answered + Overflow Answered) = (35 + 0) / (40
+ 0) = 35 / 40 = 0.875. The average speed to answer percentage (ASA%) therefore is
87.5%. If no calls have been answered within the answer threshold, the value is 0%, or if
no calls have been answered at all then the value is 100%.

Queue_Busy_Not_Available_Tim
e

Time
duration

Total time for which the agent's extension is in the Busy Not Available state, for all agents
in the queue, as displayed in the Busy Not Available Time column of Agent Summary
Report. The Busy Not Available state indicates that the agent is not available to receive
calls while performing a non call related activity such as attending a meeting. It is
independent of queue memberships and enabled state. This state can be selected by an
agent using the DND or SAC button on the phone. This also requires the agent to select
one of the reason codes displayed on the telephone to indicate the reason for getting into
the Busy Not Available state. If this state is enabled while a queue call is being presented,
the call will go to the next available agent and cause the No Answer statistic for the agent
and queue to be incremented. An agent using any DND or SAC feature is treated as
selecting the Busy Not Available state.

Queue_Customer_Calls Numeric Total number of unique calls handled by the queue, that is, the number of calls with unique
values for the Call_ID field, as displayed in the Customer Calls column in Call Summary
Report.

Queue_Grade_Of_Service_Perce
nt

Numeric Number of queue calls answered within the answer threshold as a percentage of all calls
presented, as displayed in the Grade of Service (%) column in Call Summary Report. Calls
lost before the lost call threshold are not included in the calculation, measured from when
the call was presented to the queue, and it does not include calls that are routed elsewhere
or to voicemail. It includes calls that become lost calls and overflowed answered and lost
calls. For example, with an answer threshold of 30 seconds and a lost call threshold of 5
seconds, if 20 calls into a queue are answered within the target time, 4 calls are answered
after 30 seconds and 1 call is lost after 10 seconds (no overflows). The calculation would be
(Answered Within Threshold + Overflow Answered Within Threshold) / (Answered +
Overflow Answered + Lost Outside Threshold + Overflow Lost Outside Threshold) = (20 +
0) / (24 + 0 + 1 + 0) = 20 / 25 = 0.8. The Grade of Service, therefore, is 80%. If no calls
are answered within the answer threshold, the value is 0%, or if no calls are answered or
lost at all then the value is 100%.
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Field Name Type Definition

Queue_Hold_Time Time
duration

Total time that the agent had calls on hold or calls parked, for all agents in the queue, as
displayed in the Hold Time group summary box in Agent Summary Report. In this state the
agent is not talking to a caller.

Queue_ID Numeric Unique identification number of the queue, as used in system configuration.

Queue_Inbound_Talk_Time Time
duration

Total time that the agent spent on incoming answered queue calls, not including the ringing
time, for all agents in the queue, as displayed in the Talk Inbound group summary box of
Agent Summary Report. It includes incoming external trunk calls only, not internal and
outgoing external calls. It does not include the time spent on direct calls. It excludes the
hold, parked, and ACW call time. It does not include queue calls answered by non-queue
members using methods such as call pickup.

Queue_Internal_Talk_Time Time
duration

Total time that the agent spent on internal calls, inbound and outbound, for all agents in
the queue, as displayed in the Talk Internal group summary box of Agent Summary Report.
It includes the ringing time for direct calls, but not for queue calls. It does not include held,
parked, and ACW call time. It does not include queue calls answered by non-queue
members using methods such as call pickup.

Queue_Lost_Calls Numeric Number of calls lost by the queue, as displayed in the Lost Calls column of Call Summary
Report. A lost call is one where the caller disconnected before being answered by an agent
in the queue. The lost call threshold does not impact this statistic. Queue calls that are lost
are reported as lost against both the queue and against the last agent to which the call was
presented. It does not include calls that go to voicemail. Once a call has overflowed, if lost
for the queue, it is reported as overflowed lost. Note that the number of lost calls for a
queue can be higher than the total of lost calls for the agents in the queue as calls can be
lost before being presented to any agent. 

Queue_Name Alphanume
ric

Name of the queue as configured in the IP Office telephony system, as displayed in the first
column of Call Summary Report for queues.

Queue_Non_Queue_Time Time
duration

Total time for which the agent is talking on incoming direct calls, including the ringing
times, for all agents in the queue, as displayed in the Non-Queue Time group summary box
of Agent Summary Report. It is independent of queue memberships and state.

Queue_Off_Hook_Time Time
duration

Total time for which the agent's extension was off hook but not connected to a trunk, for all
agents in the queue, as displayed in the Off Hook Time group summary box of Agent
Summary Report. It is independent of queue memberships or enabled state. Off-hook is a
telephony term for the state when the handset on a traditional telephone is lifted from the
phone, but here it is used for any state where the agent's telephone is in use but not
connected to a call. It includes all the time taken when making a call, picking up handset,
dialing, and ringing. For an external trunk it is the time until the trunk is seized. 

Queue_Outbound_Talk_Time Time
duration

Total time that an agent spent on direct outbound calls, including the ringing time, for all
agents in the queue, as displayed in the Outbound Talk group summary box of Agent
Summary Report. It is independent of queue memberships or enabled state. It does not
include the time for internal calls. It excludes the held, parked, and ACW call time. It is
unlike the real-time talk outbound statistic which considers only the time from when an
agent gets connected to an external call. 

Queue_Outside_Lost_Threshold
_Calls

Numeric Number of calls lost by a queue outside the lost call threshold, that is, the number of calls
for the queue with abandon times greater than the lost call threshold. This includes lost
calls that overflowed to the queue. This value is used in the calculation of the
Queue_Grade_Of_Service_Percent field.

Queue_Overflow_Answered_Cal
ls

Numeric Number of overflow answered calls for a queue, as displayed in the Overflow Answered
column of Call Summary Report. It shows the number of queue calls answered after
overflowing to another queue. This applies even if the overflowed call is answered by an
agent in the queue from which it overflowed. It does not include calls that go to voicemail.
It does include queue calls answered by methods such as call pickup.

Queue_Overflow_Lost_Calls Numeric Number of overflowed lost calls for the queue, as displayed in the Overflow Lost column of
Call Summary Report. It does not include calls that go to voicemail. Calls that are lost
before the lost call threshold are not counted.

Queue_Presented_Calls Numeric Sum of the answered, lost, overflow answered, overflow lost, and routed to voicemail
statistics for the queue. This statistic has the same value as the Call Interactions column of
Call Summary Report, but not the same value as Call Interactions in the Call Details Report
summary box.

Queue_Queue_Enabled_Time Time
duration

Total time for which the agents, who are members of a queue, are logged in and have the
membership of the queue reported enabled, as displayed in the HG Enabled Time group
summary box of Agent Summary Report.

Queue_Refused_Calls Numeric Number of times a call is presented to an agent in the queue and not answered before
being presented to another agent, as displayed in the No Answer (Timeout) column of Call
Summary Report. Therefore, for a queue, this is the total number of no answer events for
the agents in the queue. If an agent enables the Busy Not Available state while being
presented with a queue call, that will be counted against the agent and the queue.

Queue_Ringing_Time Time
duration

Total time that the agent's extension is ringing for incoming queue calls, for all agents in
the queue, as displayed in the Ringing Time group summary box of Agent Summary
Report. This is when an agent is being presented with a call targeted to a queue that the
agent is a member of.

Queue_Routed_To_Voicemail_C
alls

Numeric Number of queue calls presented to a queue that are routed to voicemail, as displayed in
the Routed To Voicemail column of Call Summary Report. It does not include
announcements played by the voicemail server to the caller. 

Queue_Total_Calls Numeric Sum of the answered, lost, overflow answered, overflow lost, routed to voicemail, and
refused call statistics for a queue. This is the sum of the presented calls for a queue and
the refused calls for the queue, as displayed in the Call Interactions and No Answer
(Timeout) columns of Call Summary Report.
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Dataset Definitions:  

Field Name Type Definition

Queue_Within_Answer_Thresho
ld_Calls

Numeric Number of those calls for a queue that are answered within the answer threshold time, that
is, the number of calls for the queue with answer times less than the answer threshold.
This includes answered calls that overflowed to the queue. This value is used in the
calculation of the Queue_Average_Speed_To_Answer_Percent and
Queue_Grade_Of_Service_Percent fields.

Supervisor_ID Numeric Unique identification number for the supervisor account who created the real-time alarm,
as used in system configuration.

Switch_ID Numeric Unique identification number for the IP Office telephone system, as used in system
configuration.

Switch_IP_Address Alphanume
ric

IP address configured for the IP Office telephone system, as displayed in the IP Address
column of Communication Failure Report.

Switch_Name Alphanume
ric

Name of the IP Office telephony system, as displayed in the IP Office Name column of
Communication Failure Report.

System_After_Call_Work_Time Time
duration

Total time for which the agent's extension is in the ACW state, for all agents in the system,
as displayed in the ACW Time summary box of Agent Summary Report. The ACW state
indicates that the agent is not available to receive queue calls while performing some other
call-related activity. It is independent of queue memberships and enabled state. The ACW
state is used for activities such as call records and data entry that need to be completed
before handling another call. A number of controls are available for ACW. Agents can be
configured to be automatically put into the ACW state after a queue call or they can
manually select to enter the state when required. 

Note: The ACW state is similar to busy wrap up of the CCC product.

System_Answered_Calls Numeric Number of queue calls that agents in the system have answered, as displayed in the
Answered Calls summary box of Call Summary Report. This includes calls that are shown as
routed to other in real-time. It does not include queue calls answered by non-queue
members using methods such as call pickup, or calls that go to voicemail, or direct calls
answered by agents. Once a call has overflowed, if it is answered, it is reported as
overflowed answered against the system.

System_Busy_Not_Available_Ti
me

Time
duration

Total time for which the agent's extension is in the Busy Not Available state, for all agents
in the system, as displayed in the Busy Not Available Time summary box of Agent
Summary Report. The Busy Not Available state indicates that the agent is not available to
receive calls while performing a non-call related activity such as attending a meeting. It is
independent of queue memberships and enabled state. This state can be selected by an
agent using the DND or SAC button on the phone. This also requires the agent to select
one of the reason codes displayed on the telephone to indicate the reason for getting into
the Busy Not Available state. If this state is enabled while a queue call is being presented,
the call will go to the next available agent and cause the No Answer statistic for the agent
and the queue to be incremented. An agent using any DND or SAC feature is treated as
selecting the Busy Not Available state.

System_Customer_Calls Numeric Total number of unique calls from a system wide point of view, as displayed in the
Customer Calls summary box of Call Summary Report. It is not necessarily the sum of the
per queue or per agent customer call values. For example, a call transferred between
agents would show as a unique call for each agent (two calls total) but in the summary
section it shows as a single system call. Another example would be where a call spans two
time grouping. It would show as a unique call for each of the time group (two calls total)
but in this system wide field it would show as a single system call.

System_Hold_Time Time
duration

Total time for which an agent had calls on hold or calls parked, for all agents in the system,
as displayed in the Hold Time summary box of Agent Summary Report. In this state, an
agent is not talking to a caller.

System_Inbound_Talk_Time Time
duration

Total time that an agent spent on incoming answered queue calls, not including the ringing
time, for all agents in the system, as displayed in the Talk Inbound summary box of Agent
Summary Report. It includes incoming external trunk calls only, not internal and outgoing
external calls. It does not include time for direct calls. It excludes the hold, parked, and
ACW call time. It does not include queue calls answered by non-queue members using
methods such as call pickup.

System_Internal_Talk_Time Time
duration

Total time that the agent spent on internal calls, inbound and outbound, for all agents in
the system, as displayed in the Talk Internal summary box of Agent Summary Report. It
includes the ringing time for direct calls, but not for queue calls. It does not include the
held, parked, and ACW call time. It does not include queue calls answered by non-queue
members using methods such as call pickup.

System_Lost_Calls Numeric Number of calls lost by the system, as displayed in the Lost Calls summary box of Call
Summary Report. A lost call is one where the caller disconnected before being answered by
an agent in the queue. The lost call threshold does not impact this statistic. Queue calls
that are lost are reported as lost against both the system and against the last agent to
which the call is presented. It does not include calls that go to voicemail. Once a call has
overflowed, if lost for the system, it is reported as overflowed lost. Note that the number of
lost calls can be higher than the total of lost calls for agents in the system, as calls can be
lost before being presented to any agent. 

System_Non_Queue_Time Time
duration

Total time that the agent is talking on incoming direct calls, including the ringing times, for
all agents in the system, as displayed in the Non-Queue Time summary box of Agent
Summary Report. It is independent of queue memberships and state.

System_Off_Hook_Time Time
duration

Total time for which an agent's extension is off hook but not connected to a trunk, for all
agents in the system, as displayed in the Off Hook Time summary box of Agent Summary
Report. It is independent of queue memberships or enabled state. Off-hook is a telephony
term for the state when the handset on a traditional telephone is lifted from the telephone,
but here it is used for any state where the agent's telephone is in use but not connected to
a call. It includes all the time taken when making a call, picking up handset, dialing, and
ringing. For an external trunk it is the time until the trunk is seized. 
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Field Name Type Definition

System_Outbound_Talk_Time Time
duration

Total time that the agent spent on direct outbound calls, including the ringing time, for all
agents in the system. as displayed in the Outbound Talk summary box of Agent Summary
Report. It is independent of queue memberships or enabled state. It does not include time
for internal calls. It excludes the held, parked, and ACW call times. It is unlike the real-time
talk outbound statistic which considers only the time from when an agent gets connected to
an external call. 

System_Overflow_Answered_Ca
lls

Numeric Number of overflow answered calls for the system, as displayed in the Overflow Answered
summary box of Call Summary Report. It shows the number of queue calls answered after
overflowing to another queue. This applies even if the overflowed call is answered by an
agent in the queue from which the call overflowed. It does not include calls that go to
voicemail. It does include queue calls answered by methods such as call pickup.

System_Overflow_Lost_Calls Numeric Number of overflow lost calls for the system, as displayed in the Overflow Lost summary
box of Call Summary Report. It shows the number of calls which overflowed from any
queue and were then lost. It does not include calls that go to voicemail. Calls lost before
the lost call threshold are not counted.

System_Presented_Calls Numeric Sum of the answered, lost, overflow answered, overflow lost, and routed to voicemail
statistics for all queues. This statistic has the same value as Call Interactions in Call
Summary Report summary box, but not the same as Call Interactions in the Call Details
Report summary box.

System_Queue_Enabled_Time Time
duration

Total time for which all agents of the system were logged in and had their membership of
at least one queue as reported enabled, as displayed in the HG Enabled Time summary box
of Agent Summary Report. 

System_Refused_Calls Numeric Number of times that a call is presented to an agent in the system and not answered
before being presented to another agent, as displayed in the No Answer (Timeout)
summary box of Call Summary Report. Therefore for the system, this is the total number of
no answer events for all the agents in the system. If an agent enables the Busy Not
Available state while being presented with a queue call, that will be counted against the
agent and the system. 

System_Ringing_Time Time
duration

Total time for which the agent's extension was ringing for incoming queue calls, for all
agents in the system, as displayed in the Ringing Time summary box of Agent Summary
Report. This is when the agent is being presented with a call targeted to a queue of which
they are a member.

System_Routed_To_Voicemail_
Calls

Numeric Number of queue calls presented to any queue in the system that are routed to voicemail,
as displayed in the Routed To Voicemail summary box of Call Summary Report. It does not
include announcements played by the voicemail server to the caller. 

System_Total_Calls Numeric Sum of the answered, lost, overflow answered, overflow lost, routed to voicemail, and
refused call statistics for the system. This is the sum of presented calls for the system and
refused calls for the system, as displayed in the Call Interactions and No Answer (Timeout)
summary boxes of Call Summary Report.

Total_Answered_Calls Numeric Number of calls that have reached a named Voicemail action. These are counted as
answered for that action and in total. This value is displayed in the Total Calls Answered
summary box of Voicemail Report.

Total_Lost_Calls Numeric Number of calls that have reached a named Voicemail action where the call is disconnected
by the caller or by the voicemail server before it reaches another named action. These are
counted as lost for that action and in total. This value is displayed in the Total Calls Lost
summary box of Voicemail Report.

View_ID Numeric Unique identification number for the supervisor real-time view in which the real-time alarm
is defined, as used in system configuration.



IP Office Customer Call Reporter Custom Report Walkthrough Page 33
- Issue 02a (Thursday, December 22, 2011)IP Office 8.0

Dataset Definitions:  
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Performance figures and data quoted in this document are typical, and must be
specifically confirmed in writing by Avaya before they become applicable to any
particular order or contract. The company reserves the right to make alterations
or amendments to the detailed specifications at its discretion. The publication of

information in this document does not imply freedom from patent or other
protective rights of Avaya or others.

Intellectual property related to this product (including trademarks) and registered
to Lucent Technologies have been transferred or licensed to Avaya.

All trademarks identified by the ® or ™ are registered trademarks or trademarks,
respectively, of Avaya Inc. All other trademarks are the property of their

respective owners.

This document contains proprietary information of Avaya and is not to be
disclosed or used except in accordance with applicable agreements.

 
Any comments or suggestions regarding this document should be sent to

"wgctechpubs@avaya.com".

© 2011 Avaya Inc. All rights reserved.
Avaya

Unit 1, Sterling Court
15 - 21 Mundells

Welwyn Garden City
Hertfordshire 

AL7 1LZ
England.

Tel: +44 (0) 1707 392200
Fax: +44 (0) 1707 376933
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